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UPS WorldShip 2010  
Pre-Installation Checklist

1. Check Compatibility:

	� You may have integrated UPS WorldShip with a UPS Ready® 
(or third-party) vendor application. Due to changes in the 
UPS WorldShip database structure, these applications may 
not be compatible with UPS WorldShip 2010. 

	� Do not upgrade until you contact the UPS Ready  
(or other third-party) vendor.

2. Check Operating System and Service Pack:

	� The UPS WorldShip 2010 upgrade requires that you have 
either Microsoft® Windows® 2000 Service Pack 4 (upgrade 
only), Microsoft Windows XP Service Pack 2 or higher or 
Microsoft Windows Vista®/Windows 7 to begin installation.

	� To identify which Operating System and Service Pack  
you have:

	 n �Click Start on the Windows taskbar, point to Programs, 
Accessories and System Tools and select System 
Information.

	 n �The Operating System version and Service Pack will display 
in the System Information window.

	 n �If you have Microsoft Windows XP and the Service Pack  
is lower than version 2, select the link below to download 
and install the Service Pack. The PC will be evaluated  
for available updates by Microsoft. Microsoft Windows XP 
Service Pack 2 will appear as a critical update.  
http://WindowsUpdate.Microsoft.com 

	 n �If you wish only to install Microsoft Windows XP Service 
Pack 2, clear all other updates offered.

	� Memory recommendations: 
n Windows 2000/XP (512 MB) 
n Windows Vista (1 GB) 
n Windows 7 (1 GB - 32 bit and 2 GB - 64 bit)

	 �CAUTION: Do not proceed if your system is not at the proper 
Operating System and Service Pack version.

3. Check for Administrative Rights:

	� Ensure that the user account used to log into Microsoft 
Windows operating systems has full PC administrative 
rights. If unsure, consult the computer technical support 
staff at your company. Due to security enhancements, 
Microsoft Windows Vista/Windows 7 users may be required 
to authenticate with administrative rights during the 
installation process. The User Account Control (UAC) prompt 
may appear several times during installation asking you 
for permission to let UPS WorldShip install its components. 
You must acknowledge the UAC prompt and allow the 
installation to continue.

	� Also, if you need to access the UPS WorldShip Support Utility 
for any reason, you must run this utility with administrative 
rights. To perform this task:

	 n �Click Start on the Windows taskbar, point to Programs  
and UPS, right-click UPS WorldShip Support Utility  
and select Run As Administrator.
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4. �Archive UPS WorldShip Shipping History to improve 
performance:

	 n Start UPS WorldShip.

	 n Press F3 to open the Shipping History window.

	 n On the File menu, select Archive Shipments.

	 n �In the Archive Shipments window, select All Shipments,  
or specify a date range, and then click OK.

	 n In the Save As window, click Save.

	 n �Click Yes in the confirmation window. 
�Note: The last 14 days of history will not be deleted,  
and the history that is deleted may be restored at any  
later time when needed.

	 n �Click Done when 100% is reached in the Archive 
Shipments window.

	 n �Click Yes in the window that appears requesting  
the database backup to be performed.

5. �Check for Anti-spyware, Anti-malware and Virus Scanner 
software:

	� Anti-spyware, anti-malware, and virus scanner software 
may conflict with the UPS WorldShip 2010 installation.

6. Shut Down Open Applications:

	� Shut down all other programs running on the taskbar, 
including Microsoft Outlook®, Internet Explorer®, Excel®, etc.

CAUTION: Microsoft Windows Vista/Windows 7 users please 
read below.

�During the UPS WorldShip installation process, your PC will 
be required to restart. After restart, Microsoft Windows Vista/
Windows 7 may prevent the UPS WorldShip application from 
automatically launching to complete the installation. Please 
launch UPS WorldShip using the icon on your desktop should 
this happen. If you chose not to place the UPS WorldShip icon 
on your desktop, you may launch UPS WorldShip by clicking 
Start on the Windows taskbar, pointing to Programs and UPS  
and selecting UPS WorldShip.
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Upgrading
UPS WorldShip 2010 may have different system require
ments. A complete list can be found on the CD packaging  
or at ups.com/worldship.

Note: UPS WorldShip 2010 will only upgrade UPS WorldShip 
2008 (v10) and UPS WorldShip 2009 (v11).

1. �Complete the End Of Day process prior to upgrading (if 
needed). Restart WorldShip once End Of Day has completed. 

2. �Insert the UPS WorldShip CD into the CD-ROM drive. If your 
system supports the auto-run feature, installation begins 
automatically.

	 n �If your system does not support the auto-run feature,  
click Start on the taskbar, select Run, then enter the letter 
of the CD-ROM drive, and the word setup, for example:  
D:\SETUP.

	 n �Then click OK.

3. �On the Language Selection screen, choose your language.

4. �On the Welcome to the UPS WorldShip Setup Program 
screen, click Next.

5. �Accept the UPS Technology Agreement by clicking I Accept.

6. �On the UPS WorldShip Upgrade screen, click Continue.

7. �On the Setup Review screen, confirm your selections and 
click Begin Installation.

8. �Wait while the installation process copies the files. You will 
be prompted to reboot your computer. If your PC requires a 
password, you will need to log in and enter the password. 

9. Remove the CD from the CD-ROM drive.

Installing 
You can install UPS WorldShip on a Standalone workstation 
or on a workstation that’s part of a LAN. UPS WorldShip 
should not be installed on a server.

Installing on a Standalone Workstation:
1. �Insert the UPS WorldShip CD into the CD-ROM drive. If your 

system supports the auto-run feature, installation begins 
automatically.

2. On the Language Selection screen, choose your language.

3. �On the Welcome to the UPS WorldShip Setup Program 
screen, click Next.

4. Accept the UPS Technology Agreement by clicking I Accept.

5. �On the Installation Type Selection screen, select Standalone 
Workstation and then click Next.

6. On the Setup Preferences screen, choose the following: 

	 n �Destination directory — By default, UPS WorldShip will 
install to C:\UPS\WSTD. If you choose to install in another 
directory, click Browse and then select where you want  
UPS WorldShip installed. UPS WorldShip will create the 
folders \UPS\WSTD and place them under whatever 
location you choose.

	 n �The country or territory of installation — There are four 
choices: United States/Puerto Rico, Canada, Mexico  
and Other Country/Territory.

	 n �By default, a shortcut to UPS WorldShip will be created  
on your desktop.

	 n When you are finished, click Next.

7. �On the Setup Review screen, confirm your selections  
and click Begin Installation.

8. �Wait while the installation process copies the files. You will 
be prompted to reboot your computer. If your PC requires  
a password, you will need to log in and enter the password.

9. Remove the CD from the CD-ROM drive.

Note: If you recently installed TCP/IP, Dial-Up Networking  
or a modem, you may see other windows or be asked for 
additional information.
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Installing on a Network:
If you want to allow multiple shippers to process pack-
ages using the same database, then you may install UPS 
WorldShip in a LAN configuration grouping. Installing UPS 
WorldShip in a LAN configuration requires that a single 
LAN Administrative workstation be installed first. After the 
LAN Administrative workstation has been installed, one or 
many LAN Remote workstations may be installed to share 
the database that is located on the LAN Administrative 
workstation. UPS WorldShip is designed to have the 
database reside on the LAN Administrative workstation. 
UPS WorldShip is not designed to have the database shared 
on a network file server. Additionally, a LAN configuration 
grouping requires that a “shared network drive folder” be 
defined. The shared network drive is the location for files 
(other than the database) that will need to be accessed by 
all of the workstations in the LAN configuration grouping.

Note: You can configure the Task Scheduler in UPS WorldShip 
to make daily backups of the database. Those backups could 
be stored on a server. For step-by-step instructions, select UPS 
WorldShip Help from the Help menu and type Task Scheduler.

Pre-Installation Instructions: Create a folder in which to 
install the shared UPS WorldShip files. This folder must be  
a shared Microsoft® folder and can reside on either the LAN 
Administrative workstation or on any drive that is accessible 
from the LAN Administrative workstation as well as the Remote 
workstations. These files should be installed in a different 
folder than the local files. 

LAN Administrative Workstation:
1. �Insert the UPS WorldShip CD into the CD-ROM drive.  

If your system supports the auto-run feature, installation 
begins automatically.

2. On the Language Selection screen, choose your language.

3. �On the Welcome to the UPS WorldShip Setup Program 
screen, click Next.

4. Accept the UPS Technology Agreement by clicking I Accept. 

5. �On the Installation Type Selection screen, select LAN 
Administrative Workstation and click Next.

6. On the Setup Preferences screen, choose the following:

	 n �Local Destination Directory — By default, UPS WorldShip 
will install to C:\UPS\WSTD. If you choose to install in 
another directory, click Browse and select where you 

want UPS WorldShip installed. UPS WorldShip will create 
the folders \UPS\WSTD and place them under whatever 
location you choose.

	 n �LAN Administrative Shared Location — Browse to the 
location or select the folder you created when following 
the pre-installation instructions above. This folder will 
be accessed by all Remote workstations in your UPS 
WorldShip LAN system, and it must be different than  
the local destination directory.

	 n �The country or territory of installation — There are four 
choices: United States/Puerto Rico, Canada, Mexico 
and Other Country/Territory.

	 n �By default, a shortcut to UPS WorldShip will be created  
on your desktop.

	 n When you are finished, click Next.

7. �On the Setup Review screen, confirm your selections  
and click Begin Installation.

8. �Wait while the installation process copies the files. You will 
be prompted to reboot your computer. If your PC requires  
a password, you will need to log in and enter the password.

9. Remove the CD from the CD-ROM drive.

Remote Workstation(s):
By default, the Remote workstation can perform limited 
functionality. The LAN Administrator can configure remotes  
to perform additional UPS WorldShip functions.

Note: There are two methods of installing a Remote workstation: 
installing from the CD or installing from a shared drive.

Installing from the CD:

1. �Insert the UPS WorldShip CD into the CD-ROM drive.  
If your system supports the auto-run feature, installation 
begins automatically.

2. �On the Language Selection screen, choose your language. 
Note: You must select the language that was selected by  
the LAN Administrator or you will see an error message.

3. �On the Welcome to the UPS WorldShip Setup Program 
screen, click Next.

4. Accept the UPS Technology Agreement by clicking I Accept.

5. �On the Installation Type Selection screen, select LAN Remote 
Workstation and click Next.
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6. On the Setup Preferences screen, choose the following:

	 n �Local Destination Directory — By default, UPS WorldShip 
will install to C:\UPS\WSTD. If you choose to install in 
another directory, click Browse and select where you 
want UPS WorldShip installed. UPS WorldShip will create 
the folders \UPS\WSTD and place them under whatever 
location you choose.

	 n �LAN Administrative Shared Location — Browse to the 
location or select the folder that was set up by the LAN 
Administrator.  
Note: You must browse to the location or select the folder 
that was selected by the LAN Administrator or you will see 
an error message.

	 n �The country or territory of installation — There are four 
choices: United States/Puerto Rico, Canada, Mexico  
and Other Country/Territory.

	 n �By default, a shortcut to UPS WorldShip will be created  
on your desktop.

	 n When you are finished, click Next.

7. �On the Setup Review screen, confirm your selections  
and click Begin Installation.

8. �Wait while the installation process copies the files. You will 
be prompted to reboot your computer. If your PC requires  
a password, you will need to log in and enter the password.

9. Remove the CD from the CD-ROM drive.

Installing from a shared drive:
You have the option of installing LAN Remote workstations 
from install files stored on the shared drive (the shared drive 
location was designated during the installation of the LAN 
Administrative workstation). The install files can be found in  
the \UPS\WSTD\Remote\Install\Disk1 subdirectory of the 
shared drive folder.

1. �On the Welcome to the UPS WorldShip Setup Program 
screen, click Next.

2. Accept the UPS Technology Agreement by clicking I Accept.

3. On the Setup Preferences screen, choose the following:

	 n �Local Destination Directory — By default, UPS WorldShip 
will install to C:\UPS\WSTD. If you choose to install in 
another directory, click Browse and select where you 
want UPS WorldShip installed. UPS WorldShip will create 
the folders \UPS\WSTD and place them under whatever 
location you choose.

	 n �LAN Administrative Shared Location — Note that this is the 
shared location that was set up by the LAN Administrator.

	 n �The country or territory of installation — There are four 
choices: United States/Puerto Rico, Canada, Mexico and 
Other Country/Territory.

	 n �By default, a shortcut to UPS WorldShip will be created  
on your desktop.

	 n When you are finished, click Next.

4.	�On the Setup Review screen, confirm your selections  
and click Begin Installation.

5.	�Wait while the installation process copies the files. You will 
be prompted to reboot your computer. If your PC requires  
a password, you will need to log in and enter the password.

Setting Up Communications
UPS WorldShip requires electronic communications to 
transmit package and tracking information. If you do not 
currently have direct access or dial-up access to the Internet, 
the software provides access to UPS Web sites only. 

Preparing for communications: 
To prepare for communications, the following items must  
be installed on your computer:

n For Direct Access: TCP/IP. 

n �For Dial-up Access: TCP/IP, modem, dial-up adapter  
and dial-up networking.

Configuring communications: 
When you start UPS WorldShip for the first time, you will 
see the Communications Setup window. Select at least one 
connection method and provide any necessary information  
to complete the connection setup:

n �Direct Access: a direct or broadband connection to the Internet 
that does not require dialing, such as Local Area Network (LAN), 
Wide Area Network (WAN), Digital Subscriber Line (DSL) 
or cable. Since Direct Access generally offers the fastest 
connection, UPS recommends this method. 

n �If you select Direct Access, you may need to identify the 
proxy server with the URL address, port and authorisation 
information. If a proxy server is used, you must also use 
specific browser settings.
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n �Dial-up Access: a dial-up connection to the Internet through 
your existing Internet Service Provider (ISP). If you choose 
this option, select your existing ISP from the phone book list.

Reconfiguring communications:
1.	From the Tools menu, select Communications Setup.

2.	�In the Communications Setup window, make the necessary 
changes and click Next.

3.	�Continue making changes as needed. Click Finish to save 
your new configuration.

You should reconfigure communications when any of the 
following situations occur:

n Direct access to the Internet becomes available.

n �You see a message that one of your phone numbers  
is no longer valid.

n You change Dial-up Access or you change your modem.

n You change proxy server settings for Direct Access.

n You want to select a new phone number.

n You want to add or remove a connection method.

Registering with UPS
Once the application is successfully installed, you  
must register with UPS in order to ship packages using  
UPS WorldShip.

Before you begin the registration process, make sure a printer 
is connected to your computer and is operational.

1. �After the UPS WorldShip installation is complete and you 
have set up communications, the Register With UPS window 
appears. Enter the information about your company, where 
your system is installed and your UPS account number, and 
then click Finish.

2. �UPS WorldShip automatically connects to UPS and transmits 
your registration information.

This may take three to five minutes. Please wait until the 
Shipping window appears.

Congratulations! You are now a UPS WorldShip customer  
and are ready to process packages.

Post-Installation Checklist
1. �If you disabled any anti-spyware, anti-malware or virus 

scanner software, please enable it.

2. �If you receive a message that UPS WorldShip cannot 
communicate with UPS, consult the computer technical 
support staff at your company.

3. �For UPS WorldShip LAN Administrative Workstations: 
Please be aware that the UPS WorldShip database will be 
disconnected if your LAN Administrative workstation goes 
into sleep mode. You must close UPS WorldShip on both the 
LAN Administrative and Remote workstations and relaunch 
the application to resolve this issue. If necessary, consult 
your computer technical support staff for questions about 
sleep mode and how to adjust this setting.

4. �If you have a UPS-supplied printer, restart your printer prior 
to shipping by powering it off and then powering it back on. 
If you are on Microsoft Windows Vista/Windows 7 and 
you have a UPS-supplied thermal printer (Eltron®/Zebra®), 
you must install new printer drivers. Please follow the 
instructions on the next page.

Uninstall Instructions
If you uninstall UPS WorldShip, do not delete any of its 
directories without first running the uninstall program. 
When running the uninstall program, start it from the  
Start menu, Programs, UPS, UPS WorldShip Uninstall. 
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Installation procedure for new Eltron/Zebradriver:

Note: The instructions below follow the “default view” format 
for Microsoft Windows Vista/Windows 7.

Remove current Eltron/Zebra Printers and Drivers.

  1. Click Start on the Windows taskbar and select Control Panel.

  2. Select Printers from the Hardware and Sound section.

  3. �Empty the printer queue for each Eltron, Zebra and UPS 
thermal printer (such as, UPS2844, etc.).

  4. �Delete all the Eltron, Zebra and UPS thermal printers. 
(Right-click the printer icons and click Delete.)

  5. �In the Printers window, right-click a blank space in 
the window and click Run as Administrator, Server 
Properties and the Drivers tab.

  6. �Highlight each Eltron, Zebra and UPS printer and click 
Remove.

  7. Click OK to close the Print Server Properties window.

  8. Go to C:\UPS\WSTD\FOSS\DRIVERS\ELTRON.

  9. Double-click zudrmove.exe.

10. In the Printer Uninstall Wizard window, click Next.

11. �Choose the Eltron printer(s) from the list and click OK.

12. �Uninstall all Eltron, Zebra and UPS thermal printer(s)  
from the list and click OK.

13. Run zudrmove.exe again if necessary.

14. �If no printers are listed, click Next; highlight EPL language 
and click Remove.

15. �If present, highlight ZPL Language Monitor and click Remove.

16. �Unplug the USB cable to the printers or power off  
at the back of the printers.

17. Click Next (Restart, if prompted).

18. If New Hardware Wizard appears, click Cancel.

19. Click Finish.

Installation Instructions to install Eltron/Zebra Thermal 
Label Printers on Microsoft Windows Vista/Windows 7  
with USB printers:

Note: For Serial/Parallel Printers, see next page.

  1. Launch UPS WorldShip.

  2. �On the Tools menu, select System Preferences Editor  
and then select the Printing Setup tab.

  3. Under Label Printer, click Label Printer Setup.

  4. Click Change Label Printer.

  5. �Click Add Printer, choose your printer type and click Select.

  6. �Select the language in the Language Selection window  
and click OK.

  7. In the Printer Driver Setup Wizard window, click Next.

  8. �If you select USB, the drivers will be preloaded. (Do not 
click Finish at this point.)

  9. Connect the USB printer.

10. �In the Found New Hardware window, select Locate and 
install driver software (recommended). (Click Continue  
if prompted.)

11. Select I don’t have the disc. Show me other options.

12. Select Browse my computer for driver software.

13. �Browse to C:\UPS\WSTD\FOSS\Drivers\Eltron.  
Then click OK.

14. Click Next.

15. �Select the first driver listed or Select the first driver on the list  
(c:\ups\wstd\foss\drivers\eltron\zsd.inf).

16. Click Next.

17. Select Install this driver software anyway.

18. Click Close.

19. Click Finish.

20. Click Select, then Apply, then OK.
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Installation Instructions to install Eltron/Zebra Thermal 
Label Printers on Microsoft Windows Vista/Windows 7  
with Serial/Parallel printers:

  1. Launch UPS WorldShip.

  2. �On the Tools menu, select System Preferences Editor  
and then select the Printing Setup tab.

  3. Under Label Printer, click Label Printer Setup.

  4. Click Change Label Printer.

  5. �Click Add Printer, and choose your printer type  
and click Select.

  6. �Select the language in the Language Selection window  
and click OK.

  7. In the Printer Driver Setup Wizard window, click Next.

  8. �If you use a serial or parallel interface, select Other 
Connection and click Next. You will need to select the 
manufacturer and printer from each window and then  
click Next.

  9. �Select the port used by your printer and click Next.

10. �A test page can now be sent to the printer. Click Finish.

11. �Highlight the new printer. Click Select, then Apply.

Support Guides
UPS WorldShip provides a User Guide, Installation Guide 
and Functions Shortcut Sheet in PDF format on ups.com®.

To view or print these documents, install the free Adobe® 
Reader® software from adobe.com and then follow these steps:

1. Go to ups.com/worldship.

2. Select your country/language and then click Go.

3. Select Get WorldShip Support.

4. Select Access User Guides.

5. View and print the documents as needed.
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Technical Help
If you have additional questions about UPS WorldShip 2010 that cannot be answered by this guide or UPS WorldShip Help,  
call the following numbers:

Argentina  . . . . . . . . . . . . . . . .                5411-4339-2830, 5411-4339-2831, 
5411-4339-2832, 5411-4339-2033

Armenia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 +10 3741 27 30 90

Australia  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      1800 148 934

Austria  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        0800 312 407

Azerbaijan  . . . . . . . . . . . . . . . . . . . . . . . . . . . .                            +10 99 412 493 39 91

Belarus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                    375-17-227-2233

Belgium . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        0800 21 877

Bosnia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         033 466 310

Brazil . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                     + 55 11 5694 6606

Canada . . . . . . . . . . . . . . . . . .                  1-888-UPS-TECH (1-888-877-8324)

Chile  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         562-685-0765

China, People’s Republic of . . . . . . . . . . . . . . . .                10 800 852 0698

Cyprus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           77777200

Czech Republic . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 800 143268

Denmark . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       80 33 22 55

Dominican Republic . . . . . . . . . .          809-549-9326, 809-284-5045

Estonia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       372 666 47 00

Finland . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        0800 187722

France . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         0805 025550

Germany  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                    0800 100 2630

Greece  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       210-99 84 334

Hong Kong  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       8206 2133

Hungary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       06 80016482

India  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                     00 0800 852 1113

Indonesia  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                001 803 852 3670

Ireland, Republic of  . . . . . . . . . . . . . . . . . . . . . . . . . . .                           1800 202227

Israel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 00-972-(0) 56-890028

Italy . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                            800 122 732

Japan . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        00531 85 0020

Korea, South  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                              00798 8521 3669

Latvia  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             7805643

Lithuania . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                   +370-37-350505

Luxembourg . . . . . . . . . . . . . . . . . . . . . . . . . . .                          FR: 0033 8050 10365

Malaysia  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                     1800 80 4709

Mexico . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                    01 800 714 65 35

Monaco  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                   0033 8050 10365

Netherlands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 0800 222 5587

New Zealand . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 0800 443 785

Nigeria . . . . . . . . . . . . . . . . . . . .                    234 1 2704981-5, 234 1 2704992

Norway  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         800 32 255

Philippines . . . . . . . . . . . . . . .               1 800 765 8065, 1 800 808 50020

Poland  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        02 22030321

Portugal . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        800 783458

Puerto Rico . . . . . . . . . . . . . .              1-888-UPS-TECH (1-888-877-8324)

Romania  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  +4021 233 88 77

Russia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       7 495 961 2211

Saudi Arabia  . . . . . . . . . . . . . .              966 1 462 6655, ext. 528 and 579

Singapore . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                    800 852 3362

Slovakia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                               +421 (0)2 58250 281

Slovenia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       04 281 12 42

South Africa . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                +27 11 922 9200

Spain . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                          900 22 58 77

Sweden  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       020 120 2255

Switzerland  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  0800 82 25 54

Taiwan  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      00801 855 662

Thailand . . . . . . . . .          001 800 852 3658, 02 713 6050-54 (Local)

Turkey . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                     90 212 4440066

United Arab Emirates . . . . . . . . . . .           800 4774, +971 (4) 3391939

United Kingdom . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                              0800 3316010

United States . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 888-553-1118

Uzbekistan . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                               +9987 1 120 3838


